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Preface

This preface includes the following sections:

» Audience, page vii

» Conventions, page vii

3

Related Cisco UCS Documentation, page ix

* Documentation Feedback, page ix

Audience

This guide is intended primarily for data center administrators with responsibilities and expertise in one or
more of the following:

« Server administration
* Storage administration
» Network administration

* Network security

Conventions

Text Type Indication

GUI elements GUI elements such as tab titles, area names, and field labels appear in this font.

Main titles such as window, dialog box, and wizard titles appear in this font.

Document titles Document titles appear in this font.

TUI elements In a Text-based User Interface, text the system displays appearsin this font.

System output Terminal sessions and information that the system displays appear in this
font.

Cisco UCS Platform Emulator User Guide, Release 2.2(5aPE1)
|



. Conventions

Preface

Text Type

Indication

CLI commands

CLI command keywords appear in this font.

Variables in a CLI command appear in this font.

[]

Elements in square brackets are optional.

xlylz

Required alternative keywords are grouped in braces and separated by vertical
bars.

[x1ylz]

Optional alternative keywords are grouped in brackets and separated by vertical
bars.

string

A nonquoted set of characters. Do not use quotation marks around the string or
the string will include the quotation marks.

Nonprinting characters such as passwords are in angle brackets.

Default responses to system prompts are in square brackets.

An exclamation point (!) or a pound sign (#) at the beginning of a line of code
indicates a comment line.

Means reader take note. Notes contain helpful suggestions or references to material not covered in the

document.

Means the following information will help you solve a problem. The tips information might not be
troubleshooting or even an action, but could be useful information, similar to a Timesaver.

Caution

Means reader be careful. In this situation, you might perform an action that could result in equipment

damage or loss of data.

Timesaver

Means the described action saves time. You can save time by performing the action described in the

paragraph.

- Cisco UCS Platform Emulator User Guide, Release 2.2(5aPE1)
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Related Cisco UCS Documentation .

Warning

IMPORTANT SAFETY INSTRUCTIONS

This warning symbol means danger. You are in a situation that could cause bodily injury. Before you
work on any equipment, be aware of the hazards involved with electrical circuitry and be familiar with
standard practices for preventing accidents. Use the statement number provided at the end of each warning
to locate its translation in the translated safety warnings that accompanied this device.

SAVE THESE INSTRUCTIONS

Related Cisco UCS Documentation

Documentation Roadmaps

For a complete list of all B-Series documentation, see the Cisco UCS B-Series Servers Documentation Roadmap
available at the following URL: http://www.cisco.com/go/unifiedcomputing/b-series-doc.

For a complete list of all C-Series documentation, see the Cisco UCS C-Series Servers Documentation Roadmap
available at the following URL: http://www.cisco.com/go/unifiedcomputing/c-series-doc.

For information on supported firmware versions and supported UCS Manager versions for the rack servers
that are integrated with the UCS Manager for management, refer to Release Bundle Contents for Cisco UCS
Software.

Other Documentation Resources

Follow Cisco UCS Docs on Twitter to receive document update notifications.

Documentation Feedback

To provide technical feedback on this document, or to report an error or omission, please send your comments
to ucs-docfeedback@cisco.com. We appreciate your feedback.

Cisco UCS Platform Emulator User Guide, Release 2.2(5aPE1) -
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CHAPTER 1

New and Changed Information

This chapter includes the following sections:

» New and Changed Information, page 1

New and Changed Information

The following tables provide an overview of the significant new features and behavioral changes to the Cisco

UCS Platform Emulator. The tables do not provide an exhaustive list of all changes or of the new features in
each release.

Table 1: New Features and Significant Behavioral Changes in Cisco UCS, Release 2.2(5aPE1)

New or Changed Feature Description

New Hardware support Added Haswell CPUs to the catalog.

New Software support Added support for time zone management.
New Blade Server support Added support for the following Blade servers:

» UCSB-B420-M4

* Cisco UCS Scalable M4 Blade Module for
UCSB-EX-M4-2 Blade Server

New network adapter support Added support for the UCSC-PCIE-Q8362 network
adapter.
Scaled mode servers The UCSB-EX-M4-2 Blade Server can be added in

scaled (4S) or non-scaled (2S) mode.

Cisco UCS Platform Emulator User Guide, Release 2.2(5aPE1) -
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New and Changed Information

New or Changed Feature

Description

New templates

Added the following templates for UCSB-B420-M4,
UCSC-C460-M4 , UCSB-EX-M4-1 and
UCSB-EX-M4-2 servers:

1 B420M4High

2 C460M4High

3 ExM4ScaledHigh

4 ExM4NonScaledHigh
5 ExM42ScaledHigh

6 ExM42NonScaledHigh

Table 2: New Features and Significant Behavioral Changes in Cisco UCS, Release 2.2(4bPE1)

New or Changed Feature

Description

New Network Adapter support

Added support for the following network adapters:
* UCSC-MLOM-C10T-02
* UCSB-MEZ-BRC-02
* UCSC-PCIE-C10T-02

New Fabric Extender Support

1 Added support for N2K-C2232TM-E-10GE

2 New tab Rack Integration in the navigation pane
of UCS Platform Emulator control panel. It allows
to select the desired FEX model and change the
modes of Direct Connect Rack and Single Wire
Management.

3 Added notes on Single Wire Management and
Direct Connect Rack mode regarding newly added
supported UCS C-series adapters and FEX.

- Cisco UCS Platform Emulator User Guide, Release 2.2(5aPE1)
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New and Changed Information .

New or Changed Feature

Description

New Software Features

1 Added support for the following storage profile
operations:

* Creation of a Logical Unit Number (LUN)
* Deletion of a LUN
* Modification to a LUN
* Hot Spare addition
* Removal of Hot Spares
2 Added notes on Storage Controller and Adapter
addition.

3 Added the following new templates containing
UCSC-MLOM-C10T-02 and
UCSC-PCIE-C10T-02 adapters:

* C220M4LMedium
* C240M4LMedium

4 Added notes on templates, importing from XML
and loading a saved hardware configuration

Changes to the Cisco UCS Platform Emulator VM
console

Modifications to the VM Console login
Modifications to the VM Console Options Menu
Modifications to the Network Settings

Modifications to the System Settings

N KA W N -

More details added to the Status Summary display

Table 3: New Features and Significant Behavioral Changes in Cisco UCS, Release 2.2(3aPE1)

New or Changed Feature Description

New blade server support

Added support for the Cisco UCSB-B200-M4 Blade Server
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New and Changed Information

New or Changed Feature

Description

New rack-mount server support

Added support for the following Rack Servers:
1 Cisco UCSC-C220-M4S

Cisco UCSC-C220-M4L

Cisco UCSC-C240-M4S

Cisco UCSC-C240-M4L

Cisco UCSC-C240-M4S2

Cisco UCSC-C240-M4SX

S U A WN

New network adapter support

Added support for the following network adapters:
1 UCSB-MLOM-40G-03

2 UCSC-MLOM-CSC-02

3 UCSB-VIC-M&83-8P

Configure IOM links

Provides additional flexibility to configure the connectivity
between IOM and Fabric Interconnect. You have to
configure the port numbers. It also supports Direct Connect
Rack feature.

Change of DB persistence

Whenever you perform a configuration change on the control
panel, the DB persistence gets automatically set to reset DB.

Extended direct connect Rack

UCSPE from release 2.2(3aPE1) onwards allows
configuration of multiple and different adapters on a rack
server.

Default Configuration Change

Default Hardware configuration contains a mix of M3 and
M4 blade and rack servers.

- Cisco UCS Platform Emulator User Guide, Release 2.2(5aPE1)
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New and Changed Information .

New or Changed Feature

Description

New templates

Added the following new templates for UCSB-B200-M4,
UCSC-C240-M4L/M4S/M4S2/M4SX, and
UCSC-C220-M4L/M4S servers:

o

B200M4Large
B200M4Low
B200M4Medium1
B200M4Medium?2
B200M4Medium3
B200M4Medium4
C220M4SHigh
C220M4SMediuml
C220M4SMedium?2
10 C240M4SXMedium
11 C240M4SXHighl
12 C240M4SXHigh2

o L 9 S A WN

Table 4: New Features and Significant Behavioral Changes in Cisco UCS, Release 2.2.(2cPE1)

New or Changed Feature

Description

New blade server support

Added support for the Cisco UCS Scalable M4 Blade
Module for the UCSC-B260-M4 or UCSC-B460-M4 Blade
Server

New rack-mount server support

Added support for the Cisco UCSC-C460-M4 Rack Server

New storage accelerator support

Supports the following storage accelerators:

1 Cisco UCS UCSB-F-LSI-400S storage accelerator
2 Cisco UCS UCSB-F-LSI-800S storage accelerator
3 Cisco UCS UCSB-F-FIO-785M storage accelerator
4 Cisco UCS UCSB-F-FIO-365M storage accelerator

Scriptable vMedia

Creates mounting points on the Cisco IMC. Mounts are only
configured and not actually mounted.

Storage controllers

Added a new tab called Storage Controllers under Startup
Inventory. You can drag and drop the storage controllers
on the rack-mounted servers or blade servers.
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New and Changed Information

New or Changed Feature

Description

Scaled mode servers

The Cisco UCS Scalable M4 Blade Module can be added
in scaled (4S) or non-scaled (2S) mode.

Default configuration

The default configuration is changed to M3 blade and
rack-mounted servers.

Table 5: New Features and Significant Behavioral Changes in Cisco UCS, Release 2.2.(1bPE1)

New or Changed Feature

Description

Direct connect rack

Connecting rack servers to the switch in Direct Connect
Rack mode is now supported.

Added a new tab called Direct Connect Rack under the
Navigation Pane of the UCS Platform Emulator Control
Panel.

Stripped-down firmware image

From release UCS PE 2.2 (1bPE1) onwards, download of
only the stripped-down version of UCS firmware is
supported. The stripped-down version is approximately 50
KB in size with essential firmware upgrade information.

Download from local file system

Download of UCS Manager firmware from a local file
system is now supported.

SmartPlay bundles

Supports the following SmartPlay Bundles:
1 B200 Entry Plus UCS SP7 B200EP

2 B200 Entry UCS_SP7 B200E

3 B200_ Performance UCS SP7 B200P

4 B200 Value Plus UCS SP7 B200VP

5 B200 Value UCS SP7 B200V

6 B420 Value UCS SP7 b420v

7 SWM _C220 Value Plus UCS SP7 ¢220VP
8 SWM (C220 Value UCS SP7 C220V

9 SWM_C240 Performance UCS_SP7 C240P
10 SWM_C240_Value UCS_SP7_C240P

Random statistics generation

Statistics are generated for the following component:

1 Compute servers—motherboard temperature stats,
motherboard power stats, and processor environment
stats

- Cisco UCS Platform Emulator User Guide, Release 2.2(5aPE1)
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New or Changed Feature

Description

SD card support

SD card slot in Compute servers is now supported. You can
now upgrade the SD card firmware.

Dynamically inducing and clearing faults

Inducing and clearing faults using Command Line Interface
(CLI) and observing the fault behavior in the Cisco UCS
Manager GUI is now supported.

Second-level boot order support

The Second-level boot order feature is now supported. You
can specify this feature in the service profile of the UCS
servers during association.

user-space NIC (usNIC)

The user-space NIC (usNIC) feature is now supported. You
can specify this feature in the service profile of the UCS
servers during association.

Table 6: New Features and Significant Behavioral Changes in Cisco UCS, Release 2.1(2aPE1)

New or Changed Feature

Description

Auto Install feature supported

Firmware download and upgrade is now supported. New
firmware can be downloaded either from the Cisco
Developer Network or any other source and installed on the
Platform Emulator. Upgrade of installed firmware is
supported only for B-Series and C-Series components such
as bios, adapter, Cisco IMC, and storage controller.
Installation can also be done using Host Firmware Pack and
Auto Install feature.

Single Wire Management

Added new tab called Single Wire Management under the
Navigation Pane of the UCS Platform Emulator Control
Panel

Templates

Added new tab called Templates under Hardware Catalog
of the Emulator Settings tab. Templates are pre-configured
blade and rack servers with loaded equipments. You can
drag and drop the templates on either a rack box or chassis.
The templates merge with the present configuration and fail
only when:

1 There is an overflow of connections for FEXs

2 The template configuration is unable to occupy the slot
in the chassis

Adding multiple objects in a single instance

Options to add multiple objects in a single drag and drop
instance of equipments.
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New and Changed Information

New or Changed Feature

Description

Range of slot numbers

Option to enter slot range while adding:
1 DIMM, HDD, CPU, or PSU on rack servers and chassis

2 Fans on chassis

Secure import of configuration supported

Import of a configuration from a live-UCS system using
https is supported.

Random statistics generation

Statistics are randomly for the following components:

1 Fabric Interconnect—envstats, Psu input-stats, sysstats,
Network stats

2 Chassis—Fan Stats, Psu input-stats

3 FEX—envstats

New rack-mount server support

Added support for the following rack-mount servers:
1 Cisco UCS C260 M2 Rack Server
2 Cisco UCS C460 M2 Rack Server
3 Cisco UCS C420 M3 Rack Server

New blade server support

Added support for Cisco UCS B-420 M3 Blade Server

New network adapter support

Added support for the following network adapters:
1 Cisco UCS CNA M73KR-E Emulex Adapter
2 Cisco UCS CNA M73KR-Q Qlogic Adapter

SmartPlay bundles

Added a new icon under the working pane of Startup
Inventory page.

Moved Hardware Inventory Menu Tab

Moved Hardware Inventory Menu Tab from the
Navigation Pane to Emulator Settings Menu Tab

Table 7: New Features and Significant Behavioral Changes in Cisco UCS, Release 2.1(1aPE1) and Release 2.1(1aPE2)

New or Changed Feature

Description

Cluster support

Added cluster support with dual-fabric interconnects
simulated on the same virtual machine.

Validation option

Added a validate configuration option in the GUI

- Cisco UCS Platform Emulator User Guide, Release 2.2(5aPE1)
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New or Changed Feature

Description

Backup and Restore

Added backup and restore configuration options.

Unified port support

Added unified port support for the Cisco UCS 6248UP and
Cisco 6296UP fabric interconnects.

New rack-mount server support

Added support for the following rack-mount servers:
1 Cisco UCS C200 M1 High-Density Rack-Mount Server
2 Cisco UCS C200 M2 High-Density Rack-Mount Server

3 Cisco UCS C210 M1 General-Purpose Rack-Mount
Server

4 Cisco UCS C210 M2 General-Purpose Rack-Mount
Server

5 Cisco UCS C250 M1 Extended-Memory Rack-Mount
Server

6 Cisco UCS C250 M2 Extended-Memory Rack-Mount
Server

7 Cisco UCS C220 Rack Server
8 Cisco UCS C240 Rack Server
9 Cisco UCS C22 Rack Server
10 Cisco UCS C24 Rack Server

New blade server support

Added support for the following blade servers:
1 Cisco UCS B-22 Blade Server

2 Cisco UCS B-250 Blade Server

3 Cisco UCS B-440 Blade Server

New network adapter support

Added support for the following network adapters:
Cisco UCS VIC M828P Virtual Interface Card
Cisco UCS VIC 1240 Virtual Interface Card

Cisco UCS VIC 1225 Virtual Interface Card
Emulex OCel11102-F Converged Network Adapter
Qlogic QLE&242 Converged Network Adapter

A N A W N -

Broadcom NetXtreme 11
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New and Changed Information

New or Changed Feature

Description

New Fabric Extender (FEX) support

Added support for the Cisco Nexus 2232PP Fabric Extender.

Added an automatic rack server to fabric extender
configuration.

VM Console

Added information to use the vin console to change network
settings and to change the cluster status.

Database Persistence Settings

Added requirement to use the Cisco UCS Platform Emulator
GUI only to change the persistent settings for the database
(to reset or to preserve the database upon a restart).

Launching UCSPE

Added information to launch UCSPE using VMplayer,
VMfusion, VMware vSphere Hypervisor (ESXi) , and
Microsoft Hyper-V - on Windows or Linux.

System Requirements

Updated requirements.

Known Issues

Removed limitation about high availability mode.

Table 8: New Features and Significant Behavioral Changes in Cisco UCS, Release 2.0(2s)

New or Changed Feature

Description

support

Enhanced fabric interconnect high availability

Added an option to switch between standalone and cluster
modes for the emulated fabric interconnects.

New blade server

Added support for the Cisco UCS B200 M3.

New fabric interconnects

Added support for the Cisco UCS 6248 and 6296 fabric
interconnects.

New I/O module

Added support for the Cisco UCS 2208XP 1/0 module.

and fabric interconnects

Enhanced connectivity between I/0O modules

Added support for 1, 2, 4, or 8 uplinks from an I/O module
to a fabric interconnect.
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CHAPTER 2

Overview

This chapter includes the following sections:

 Information About Cisco UCS Platform Emulator, page 11

» Cisco UCS Platform Emulator Control Panel, page 11

Information About Cisco UCS Platform Emulator

A

Cisco UCS Platform Emulator is the Cisco UCS Manager application bundled into a virtual machine (VM).
The VM includes software that emulates hardware communications for the Cisco Unified Computing System
(Cisco UCS) hardware that is configured and managed by Cisco UCS Manager.

For example, you can use Cisco UCS Platform Emulator to create and test a supported Cisco UCS configuration,
or to duplicate an existing Cisco UCS environment for troubleshooting or development purposes.

Note

For the latest hardware and software feature information, prerequisites, limitations, and caveats, see the
release notes for Cisco UCS Platform Emulator.

Cisco UCS Platform Emulator Control Panel

Navigation Pane

The Navigation pane displays on the left side of the Cisco UCS Platform Emulator Control Panel. This pane
enables you to navigate to all components in the Cisco UCS Platform Emulator.

UCS MANAGER Menu Tab

The items in this menu tab provide access to Cisco UCS Manager and its functionality within Cisco UCS
Platform Emulator.

Cisco UCS Platform Emulator User Guide, Release 2.2(5aPE1) -
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. Work Pane

EMULATOR SETTINGS Menu Tab

The items in this menu tab enable you to configure the settings for Cisco UCS Platform Emulator.

RESTART Menu Tah

The items in this menu tab enable you to access the restart options for Cisco UCS Platform Emulator.

Work Pane

The Work pane displays on the right side of Cisco UCS Platform Emulator Control Panel. The Work pane
includes a content area that displays information related to the menu item selected in the Navigation pane.
You can view and modify information in the Work pane.

- Cisco UCS Platform Emulator User Guide, Release 2.2(5aPE1)



CHAPTER

Installing and Running Cisco UCS Platform
Emulator Using the VM Console

This chapter includes the following sections:

3

IP Address for Cisco UCS Platform Emulator, page 13

« Installing and Launching Cisco UCS Platform Emulator, page 14

» Launching Cisco UCS Platform Emulator Using Hypervisors, page 14

» Viewing System Settings Using VM Console, page 16

* Modifying System Settings Using VM Console, page 17

* Modifying Network Settings Using the VM Console, page 18

» Restarting and Rebooting Cisco UCS Platform Emulator Using the VM Console, page 18
 Starting the Cisco UCS Manager CLI Using the VM Console, page 19

IP Address for Cisco UCS Platform Emulator

Cisco UCS Platform Emulator supports both DHCP and static IP. By default, Cisco UCS Platform Emulator
is configured to use the local network to obtain an IP address via DHCP. If your network does not include a
DHCEP server, you must assign a static [P address to Cisco UCS Platform Emulator.

After the initial installation completes, Cisco UCS Platform Emulator displays the management IP address in
the VM console. If you assign a static IP address, the IP address persists across VM reboots. If the IP address
was assigned by DHCP server, the IP address persists across VM reboots for the duration of the lease.

Note

When connecting to the UCS Platform Emulator VM Console through the SSH, we recommend that you
keep open a single session.
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. Installing and Launching Cisco UCS Platform Emulator

Installing and Launching Cisco UCS Platform Emulator

~

Note

Step 1
Step 2

Step 3

Step 4

Launching

The VM performs a one-time installation process the first time it starts up. Allow the installation to
complete before you reboot the VM.

Procedure

Extract the Cisco UCS Platform Emulator .zip file and .ova file to a folder.

Open or import the unzipped Cisco UCS Platform Emulator into a supported hypervisor, as required by the
hypervisor.
Do not continue with the next step until the VM has finished booting.

(Optional) If you have a DHCP server setup, the Cisco UCS Platform Emulator requests for the IP addresses
from the DHCP server during startup and the IP assigned is displayed on the login screen. Enter this IP address
in a supported Mozilla-based web-browser to open the home screen of Cisco UCS Platform Emulator.
(Optional) If you want to assign a static IP address to Cisco UCS Platform Emulator, do the following:
a) Inthe VM console window, at the ucspe login prompt, enter ucspe and press Enter.
b) At the Password prompt, enter ucspe and press Enter.
c) Atthe Select prompt, enter n to change the network settings. A brief overview of current network settings
is displayed.
d) At the Modify Connections prompt, enter y to modify connections.
e) Atthe Set Network Mode prompt, enter ¢ to configure custom network.
Repeat the following steps f. and g. three times, one for each interface.

f) At the Enter <Interface> IP prompt, enter the static IP address to configure and press Enter.
g) At the Enter <Interface> Netmask prompt, enter the Netmask to configure and press Enter.
h) At the Enter Gateway IP prompt, enter the IP address of the default gateway press Enter.

After you enter the default gateway, the network interface reinitializes with your settings and the system
becomes accessible through the new IP address. To cancel an entry and return to the menu, press Ctrl+C.

Cisco UCS Platform Emulator Using Hypervisors

You can launch Cisco UCS Platform Emulator using VMplayer, VMfusion, VMware vSphere Hypervisor
(ESXi), and Microsoft Hyper-V.

Launching Cisco UCS Platform Emulator Using Hypervisors With An . ova File
Using VMplayer on Microsoft Windows and Linux, Release 5.0:

1 Download the VMware OVF Tool, Release 3.0.1 from VMware. You can download the tool from the
website.

Cisco UCS Platform Emulator User Guide, Release 2.2(5aPE1)
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Launching Cisco UCS Platform Emulater Using Hypervisors .

2 When the download is complete, open your terminal or command prompt, navigate to where the VMware

OVF Tool was installed and run the following to convert the image to a VMX file:
ovftool <path to ova\UCSPE.ova> <path to store converted image\UCSPE.vmx>

The conversion begins and a progress window is displayed. When finished, you can use VMware player
to open the converted image and launch Cisco UCS Platform Emulator.

3 From the File menu on the VMware Player menu bar, select Open a Virtual Machine.

4 Browse to the folder where the VMX file was converted and double-click the VMX file to launch Cisco
UCS Platform Emulator.

Launching Cisco UCS Platform Emulator Using Hypervisors With a . zip File

The . zip file contains the VMX and VMDK files that can be used directly with VMware Player, VMware
Workstation and VMware Fusion.

1 Download the . zip file.
Extract the . zip file to a folder.
Click Open a Virtual Machine and browse to the extracted files. Select the VMX file and click Open..

S W N

To install in vSphere, the VMDK files must be processed with VMware Converter Standalone, then
deployed to vCenter directly.

5 Open VMware Converter Standalone.

6 Inthe Converter view pane, select Convert Machine

7 Set the source type as VMware Workstation or Other Virtual Machine.
8 Select the VMX file from the folder. Click Next.

9 Enter the destination information for the vCenter Server.

10 Select a destination cluster resource, and suitable datastore.

11 Click on Finish

12 When the conversion completes successfuly, power on the VM.

Launching Cisco UCS Platform Emulator Using Microsoft Hyper-V With a . zip File

Note

This task applies to the .zip file only; for example,

Cisco UCS Platform Emulator 2.2 (5aPEl) .zip.Cisco UCS Platform Emulator is delivered
asan .ova fileand as a . zip file. Each file contains the VMX and VMDK files that can be used directly
with VMware Player, VMware Workstation and VMware Fusion.

1 Download the . zip file.
2 Extract the . zip file to a folder.

3 Download the StarWind V2V converter from www.starwindsoftware.com. Install the converter in Microsoft
Windows.
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4 Launch the StarWind converter and convert the UCSPE.vmdk file into VHD format. Use the Microsoft
Virtual PC growable image as the destination image format.

5 Power on the VM.

Launching Cisco UCS Platform Emulator Using VMware Fusion on Mac 0S X With an .ova File

If you are running VMware Fusion 4 or below, you can use the VMware OVF Tool to convert the image to
the VMware runtime file format (.vmx). VMware Fusion 5 can import the .ova image file without conversion.

1 From the File menu on the VMware Fusion menu bar, select Import. The Import Library window displays
a dialog box for browsing to the location of the .ovf file.

2 Browse to the .ova file and click Open.

3 Type the name for the imported virtual machine in the Save As text box and indicate where to save it. The
default destination is the Virtual Machines folder created by VMware Fusion.

4 Click Import. A status bar indicates the progress of the import process.

When the import is complete, the virtual machine appears in the virtual machine library and in a separate
virtual machine window.

Launching Cisco UCS Platform Emulator Using VMware Workstation on Microsoft Windows and Linux With
an .ova File

You can directly import an .ova file into VMware Workstation 8.
1 From the File menu on the VMware Workstation 8 menu bar, select Open.
2 Browse to the .ovf or .ova file and click Open.

3 Type aname for the virtual machine, browse to the directory for the virtual machine files, and click Import.

Launching Cisco UCS Platform Emulator Using VMware vSphere ESXi 5.0 With an .ova File
Connect to your VMware Vcenter or VMware vSphere ESXi using the vSphere client.

1 From the File menu in the Vcenter or ESXi menu bar, select Deploy OVF Template.

2 Browse to the .ova file and click Open.

Viewing System Settings Using VM Console

Step 1
Step 2

Step 3

- Cisco UCS Platform Emulator User Guide, Release 2.2(5aPE1)

You can use the Cisco UCS Platform Emulator VM console to view system status and configurations.

Procedure

At the ucspe login, enter the username ucspe and press Enter.

At the Password prompt, enter ucspe and press Enter.
The VM console displays the Options menu.

At the Select prompt, enter a to show the status and press Enter.
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Multiple system statuses and configurations are displayed:
¢ The current version of Cisco UCS Platform Emulator is displayed on top.
¢ The current Network Mode and the Network Interface Configurations are displayed.

¢ The Cisco UCS Platform Emulator System Settings such as Cluster Mode, Single-wire Management
Mode, Direct Connect Rack Mode, Cisco UCS Manager Database Persistence Mode, and multiple
uplinks are displayed.

Modifying System Settings Using VM Console

You can use the Cisco UCS Platform Emulator VM console to change some of the UCS Platform Emulator
configurations.

Procedure

Step1 At the ucspe login, enter the username ucspe and press Enter.

Step2 At the Password prompt, enter ucspe and press Enter.
The VM console displays the Options menu.

Step3 At the Select prompt, enter t to modify system settings.
Step4 At the Modify System Settings, select one of the following options:

a) Enter d to modify Direct Connect Rack Mode and press Enter. The current status of the Direct Connect
Rack Mode is displayed (On or Off).
- At the Set Direct Connect Rack mode prompt, enter 0 to turn it Off or 1 to turn it On, and press Enter.
After modification, the Cisco UCS Platform Emulator and Cisco UCS Manager restart.

b) Enter h to modify High-Availability Mode and press Enter. The current status of the High Availability
Mode is displayed (Stand Alone or Clustered).
- At the Set High Availability prompt, enter s to change to Stand Alone or ¢ to change to Clustered, and
press Enter. After modification, the Cisco UCS Platform Emulator and Cisco UCS Manager restart.

¢) Enter p to modify the (UCSM) Database Persistence and press Enter. The current status of the UCSM
Database Persistence status is displayed (ON or OFF).
- At the Set Database Persistence Mode prompt, enter 0 to turn it OFF or 1 to turn it ON, and press Enter.
After modification, the Cisco UCS Platform Emulator and Cisco UCS Manager restart.

d) Enter s to modify Single Wire Management Mode and press Enter. The current status of the Single Wire
Management Mode is displayed(On or Off).
— At the set Single Wire Management Mode prompt, enter 0 to turn it Off or 1 to turn it On, and press
Enter. After modification, the Cisco UCS Platform Emulator and Cisco UCS Manager restart.

e) Enter u to modify number of uplinks and press Enter. The current status of the number of uplinks is
displayed (range between 1 and 4).
- At the Set Number of Uplinks <range> prompt, enter the desired number within the specified range
and press Enter. After modification, the Cisco UCS Platform Emulator and Cisco UCS Manager restart.
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Note  If you entered invalid data in the settings, the modification process aborts and the system reverts to
the original menu options.

Modifying Network Settings Using the VM Console

Step 1
Step 2

Step 3

Step 4
Step 5

You can use the Cisco UCS Platform Emulator VM console to change some network settings of the VM.

Procedure

At the ucspe login, enter the username ucspe and press Enter.

At the Password prompt, enter ucspe and press Enter.
The VM console displays the Options menu.

At the Options Select prompt, enter n to modify network settings.
A brief summary of current network settings with the IP address, netmask and hardware address of the
interfaces, is displayed.

At the Modify Connections prompt, enter y and press Enter.

Atthe Set Network Mode prompt, choose the network mode by entering a for Auto Mode; d for DHCP Mode
and ¢ for Custom Mode.

* Auto Mode—This is the default mode of the Cisco UCS Platform Emulator. In this mode, the Cisco
UCS Platform Emulator checks for DHCP servers first as shown below.

* DHCP Mode—In this mode, the Cisco UCS Platform Emulator searches only for an available DHCP
Server. Upon obtaining IP addresses for all the interfaces, the Cisco UCS Platform Emulator and Cisco
UCS Manager restart automatically.

* Custom Mode— In this mode, the Cisco UCS Platform Emulator skips checking for available DHCP
servers and directly uses the custom configuration that the user provides. Complete steps a and b once
if Cluster Mode is Stand Alone, and thrice if Cluster Mode is Clustered.

a) At the Enter eth[0,1,2] IP prompt, enter the static IP address for the interface.
b) At the Enter eth[0,1,2] Netmask prompt, enter the netmask for the interface.
c) Atthe Enter Gateway IP prompt, enter the default gateway IP address.

The Cisco UCS Platform Emulator and Cisco UCS Manager restarts and come up with the configured IP
address.

Restarting and Rebooting Cisco UCS Platform Emulator Using
the VM Console

You can use the Cisco UCS Platform Emulator VM console to restart and reboot UCSPE.

Cisco UCS Platform Emulator User Guide, Release 2.2(5aPE1)
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A

Starting the Cisco UCS Manager CLI Using the VM Console .

Note

Step 1
Step 2

If you restart or reboot using the VM console, the Cisco UCS Manager database will only be reset if the
persistent setting is configured to reset the database. You can configure the persistent setting in the Cisco
UCS Platform Emulator VM Console (See Modifying System Settings Using VM Console, on page 17)
or using the Cisco UCS Platform Emulator GUI (Emulator Settings > Database Persistence > Preserve
or Reset).

Procedure

At the cisco-ucspe login prompt, type username ucspe and press Enter.

At the Password prompt, type ucspe and press Enter.
The VM console window displays the Options menu.

a) Press s to restart Cisco UCS Platform Emulator processes and press Enter. At the Confirm prompt, enter
y and press Enter. This restarts all the Cisco UCS Platform Emulator processes including the Cisco UCS
Manager process. The Cisco UCS Manager Database resets or is preserved based on the configuration.
(To change this, see the Modifying System Settings Using VM Console, on page 17 section).

b) Press fto perform a Factory Reset and press Enter. At the Confirm prompt, enter y and press Enter. This
resets all configurations and settings to the original settings of the Cisco UCS Platform Emulator.

c) Press r to reboot the VM and press Enter. At the Confirm prompt, enter y and press Enter. This restarts
the VM.

d) Press x to logout user and press Enter. At the Confirm prompt, enter y and press Enter. This logs out
the current Cisco UCS Platform Emulator user and takes you back to the login screen.

e) Presszto shutdown the VM and press Enter. At the Confirm prompt, enter y and press Enter. This shuts
down the VM.

Starting the Cisco UCS Manager CLI Using the VM Console

You can use the supported commands from the Cisco UCS Manager CLI to configure and manage the hardware
in your Cisco UCS Platform Emulator environment. The console window for the Cisco UCS Platform Emulator
VM supports a single CLI session.

For information about Cisco UCS Manager CLI commands, see the Cisco UCS Manager CLI Configuration
Guide and the Cisco UCS Manager CLI Command Reference. You can access these documents through the
Cisco UCS B-Series Servers Documentation Roadmap available at the following URL: http://www.cisco.com/
go/unifiedcomputing/b-series-doc .

Note

Cisco UCS Platform Emulator does not support Cisco UCS Manager CLI commands for unsupported
features or within the connect nxos or connect local-mgmt scopes
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Procedure

Step1 At the ucspe login prompt, type username ucspe and press Enter.
Step2 At the Password prompt, type ucspe and press Enter.
The VM console displays the Options menu.

Step3 Press ¢ to log on to the CLI console and press Enter
The VM Console window now displays the ucspe# prompt, which is the equivalent of the top-level scope in
the Cisco UCS Manager CLI.
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CHAPTER I

Restarting and Shutting Down Cisco UCS
Platform Emulator Using the Control Panel

This chapter includes the following sections:

» Restarting Cisco UCS Platform Emulator, page 21

 Persisting Settings During a Cisco UCS Platform Emulator Restart, page 22

» Restarting Cisco UCS Platform Emulator and Performing a Factory Reset, page 22
» Rebooting the Cisco UCS Platform Emulator VM, page 23

* Shutting Down the Cisco UCS Platform Emulator VM, page 23

Restarting Cisco UCS Platform Emulator

Procedure

Step1 In the Navigation pane, click the Restart menu tab.
Step2 Click Restart UCSPE.

Step3 In the Are you sure you want to restart UCS Emulator with Current Settings now? field of the Work
pane, click one of the following radio buttons:

* Yes—To restart Cisco UCS Platform Emulator with current settings.

* No—To cancel the action.

Step4 Click Restart UCS Emulator with Current Settings.

Cisco UCS Platform Emulator User Guide, Release 2.2(5aPE1)
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. Persisting Settings During a Cisco UCS Platform Emulator Restart

Persisting Settings During a Cisco UCS Platform Emulator

Restart

When Cisco UCS Platform Emulator restarts, the database either persists or is reset depending on the persistence
setting made in the Cisco UCS Platform Emulator GUI . By default, this procedure erases all settings and
configuration in the database, including pools, policies, and service profiles. However, you can configure
Cisco UCS Platform Emulator to preserve the database upon restart using the Cisco UCS Platform Emulator
GUI (Emulator Settings > Database Persistence > Preserve or Reset).

Procedure
In the Navigation pane, click Emulator Settings > Database Persistence, click one of the following radio

buttons:

* Yes—To restart the Cisco UCS Platform Emulator and reset the database to erase all settings and
configuration.

* No—To cancel the action.

Restarting Cisco UCS Platform Emulator and Performing a
Factory Reset

Step 1
Step 2
Step 3

Step 4

By default, when Cisco UCS Platform Emulator restarts, the database is erased, any hardware that you added
to Cisco UCS Manager within Cisco UCS Platform Emulator is deleted, and all configurations and settings
are returned to the factory defaults.

Procedure

In the Navigation pane, click the Restart menu tab.
Click Factory Reset.

In the Are you sure you want to perform Factory Reset now? field of the Work pane, click one of the
following radio buttons:

* Yes—To restart the Cisco UCS Platform Emulator and erase all hardware, settings, and configuration

* No—To cancel the action.

Click Perform Factory Reset.
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Rebooting the Cisco UCS Platform Emulator VM

Rebooting the VM from the Cisco UCS Platform Emulator ensures a clean shutdown of the Cisco UCS
Platform Emulator before the VM reboots.

A

Note  If clustering is disabled, you must set a static IP address.

Procedure

Step1 In the Navigation pane, click the Restart menu tab.
Step2 Click Reboot VM.

Step3 In the Are you sure you want to reboot Virtual Machine now? field of the Work pane, click one of the
following radio buttons:

* Yes—To shutdown the Cisco UCS Platform Emulator and reboot the VM

* No—To cancel the action.

Step4 Click Reboot Virtual Machine.

Shutting Down the Cisco UCS Platform Emulator VM

Shutting down the VM from the Cisco UCS Platform Emulator ensures a clean shutdown of the Cisco UCS
Platform Emulator.

Procedure

Step1 In the Navigation pane, click the Restart menu tab.
Step2 Click Shutdown VM.

Step3 Inthe Are you sure you want to shut down Virtual Machine now? field of the Work pane, click one of
the following radio buttons:

* Yes—To shutdown the VM

* No—To cancel the action.

Step4 Click Shut Down Virtual Machine.
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CHAPTER 5

Configuring Cisco UCS Platform Emulator

This chapter includes the following sections:

Status Summary Page, page 25

Viewing the Cisco UCS Platform Emulator Current Status and Settings, page 27
Modifying the Cisco UCS Manager High Availability Setting, page 27

Modifying the Cisco UCS Manager Single Wire Management Setting, page 28
Modifying the Cisco UCS Manager Direct Connect Rack Setting, page 29
Moditying the Cisco UCS Platform Emulator Startup Configuration Source, page 31
Modifying the Fabric Interconnect Emulation Settings, page 32

Dynamically Inducing and Clearing Faults, page 33

Server Specific Sensor Listing for Blade and Rack Mounted Servers, page 34
Modifying Cisco UCS Configure IOM Links, page 38

Status Summary Page

The Status Summary page displays the current status and a summary of the Cisco UCS Platform Emulator
settings. These settings are updated when you modify any of the Cisco UCS Platform Emulator settings.

Runtime Status Area

This area provides information about the current status of Cisco UCS Platform Emulator. The number in
parentheses shows the number of instances of the processes that are running. This example is for a cluster
setting. For a non-cluster (standalone setting), everything will be (1) and the SAM Controller will not be

running.
Name Description
Emulator field Running(1)
UCS Manager field Running(2)
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Name Description

Blade AG field Running(2)

RsdAG field Running(2)

PortAG field Running(2)

StatsAG field Running(2)

NicAG field Running(2)

DeosAG field Running(2)

HostagentAG field Running(2)

ExtvmmAG field Running(2)

SAM Controller field Running(2)

Available Memory field The memory currently available to Cisco UCS Platform Emulator.
Current Mgmt IP field The current management IP address.

Netmask field The netmask configured for Cisco UCS Platform Emulator.
Gateway field The gateway configured for Cisco UCS Platform Emulator.

Emulator Startup Settings Area

This area provides details of the fabric interconnect configuration for Cisco UCS Platform Emulator.

Name Description

High-Availability Mode field The number of fabric interconnects configured for Cisco UCS Platform
Emulator. This can be one of the following:

* High availability cluster configuration with two fabric
interconnects

» Single standalone fabric interconnect

Persistent DB Mode field Whether the database is preserved or erased when Cisco UCS Platform
Emulator is restarted.

# of Fabric Interconnect Uplinks | The number of uplinks between the chassis and the fabric interconnects.
field
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Viewing the Cisco UCS Platform Emulator Current Status and Settings .

Emulator Hardware Config Area

Name Description

Startup Config URL field The location where the startup configuration for Cisco UCS Platform
Emulator is stored.

Viewing the Cisco UCS Platform Emulator Current Status and

Settings

Step 1
Step 2
Step 3

Procedure

In the Navigation pane, click the Emulator Settings menu tab.
Click Status Summary.
In the Work pane, review the current status and settings of Cisco UCS Platform Emulator.

Modifying the Cisco UCS Manager High Availability Setting

The High Availability setting determines which of the following configurations is emulated by Cisco UCS
Platform Emulator:

* High availability cluster configuration with two fabric interconnects

* Single standalone fabric interconnect

Note

Step 1
Step 2
Step 3

Changes to this setting do not take effect until you restart the Cisco UCS Platform Emulator. If you restart
or reboot Cisco UCS Platform Emulator, the Cisco UCS Manager database will only be reset if the persistent
setting is configured to reset the database. You can configure the persistent setting in the Cisco UCS
Platform Emulator VM Console (See Modifying System Settings Using VM Console, on page 17) or
using the Cisco UCS Platform Emulator GUI (Emulator Settings > Database Persistence > Preserve
or Reset).

Procedure

In the Navigation pane, click the Emulator Settings menu tab.
Click High Availability.

Click one of the following radio buttons:

 Dual Fabric Interconnect, HA
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* Single Fabric Interconnect, no HA

Step4 Click Submit.

What to Do Next

Configuring Cisco UCS Platform Emulator

Restart the VM and reset the database, as described in Persisting Settings During a Cisco UCS Platform

Emulator Restart, on page 22.

Modifying the Cisco UCS Manager Single Wire Management

Setting

In Single Wire Management mode, the servers can be managed using only one wired connection to the
adapter. You can perform a full reset of Cisco UCS Platform Emulator database using Single Wire
Management. The server platform slots supported by Single Wire Management are:

Adapter

Rack Server Model

Adapter Slots

UCSC-PCIE-CSC-02/

UCSC-BASE-M2-C460

1

UCSC-PCIE-CSC-02/

C260

UCSC-PCIE-C10T-02/

UCSC-MLOM-CI10T-02 (for
M4 servers only)

UCSC-PCIE-CSC-02/

UCSC-MLOM-CSC-02 (for
M4 servers only)

C220-M3/C220-M4

UCSC-PCIE-C10T-02/

UCSC-MLOM-C10T-02 (for
M4 servers only)

UCSC-PCIE-CSC-02/

UCSC-MLOM-CSC-02 (for
M4 servers only)

C240-M3/C240-M4

UCSC-PCIE-C10T-02
UCSC-PCIE-CSC-02/

C22

UCSC-PCIE-C10T-02
UCSC-PCIE-CSC-02/

C24

UCSC-PCIE-CSC-02/

C420
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Adapter Rack Server Model Adapter Slots

UCSC-PCIE-CSC-02 UCSC-C460-M4 4
UCSC-PCIE-C10T-02

UCSC-PCIE-CSC-02 UCSC-C420-M3 4
UCSC-PCIE-C10T-02

A

Note  Changes to this setting do not take effect until you restart the Cisco UCS Platform Emulator. If you restart
or reboot Cisco UCS Platform Emulator, the Cisco UCS Manager database will only be reset if the persistent
setting is configured to reset the database. You can only configure the persistent setting in the Cisco UCS
Platform Emulator GUI (Emulator Settings > Database Persistence > Preserve or Reset).

Note * To turn On a Single Wire Management Mode, select Off for Direct Connect Rack Mode.

« If FEX N2K-C2232TM-E-10GE is selected, UCSC-PCIE-C10T-02 and UCSC-MLOM-C10T-02
can be connected to it. Therefore, other adapters does not appear in the catalog. The same applies
for Templates of Rack Servers that contain adapters other than these.

Also, if FEX N2K-C2232PP-10GE is selected, UCSC-PCIE-C10T-02 and UCSC-MLOM-C10T-02
does not appear in the catalog as these adapters cannot be connected to this FEX. Templates of Rack
Servers containing these adapters disappears from the catalog.

Procedure

Step1 In the Navigation pane, click the Emulator Settings menu tab.

Step2 Click Rack Integration.

Step3 Select On or Off from the Single Wire Management drop-down menu.
Step4 Click Submit.

What to Do Next

Restart the VM and reset the database, as described in Persisting Settings During a Cisco UCS Platform
Emulator Restart, on page 22.

Modifying the Cisco UCS Manager Direct Connect Rack Setting

In Direct Connect Rack mode, the servers are directly connected to the switch with no intermediate Fabric
Extender (FEX) connectivity. The rack server platform slots supported by Direct Connect Rack are:
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A

Configuring Cisco UCS Platform Emulator

Adapter

Rack Server Model

Adapter Slots

UCSC-PCIE-CSC-02/

UCSC-BASE-M2-C460

1

UCSC-PCIE-CSC-02/

C260

UCSC-PCIE-C10T-02/

UCSC-MLOM-C10T-02 (for
M4 servers only)

UCSC-PCIE-CSC-02/

UCSC-MLOM-CSC-02 (for
M4 servers only)

C220-M3/C220-M4

UCSC-PCIE-C10T-02/

UCSC-MLOM-C10T-02 (for
M4 servers only)

UCSC-PCIE-CSC-02/

UCSC-MLOM-CSC-02 (for
M4 servers only)

C240-M3/C240-M4

UCSC-PCIE-C10T-02

C22

UCSC-PCIE-C10T-02
UCSC-PCIE-CSC-02/

C24

UCSC-PCIE-CSC-02/

C420

UCSC-PCIE-CSC-02
UCSC-PCIE-C10T-02

UCSC-C460-M4

UCSC-PCIE-CSC-02
UCSC-PCIE-C10T-02

UCSC-C420-M3

Note

Changing the Direct Connect Rack setting resets the Cisco UCS Platform Emulator database. Also, once
the Direct Connect Rack option is enabled, it automatically enables the Single Wire Management mode.
Changing the settings do not take effect until you restart the Cisco UCS Platform Emulator. If you restart
or reboot the Cisco UCS Platform Emulator, the Cisco UCS Manager database will reset if the persistent
setting is configured to reset the database. You can configure the persistent settings only in the Cisco UCS
Platform Emulator GUI (Emulator Settings > Database Persistence > Preserve or Reset).
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A

Modifying the Cisco UCS Platform Emulator Startup Configuration Source .

Note

Step 1
Step 2
Step 3
Step 4

¢ To turn On a Direct Connect Rack Mode, select On for Single Wire Management Mode.

« If FEX N2K-C2232TM-E-10GE is selected, UCSC-PCIE-C10T-02 and UCSC-MLOM-C10T-02
can be connected to it. Therefore, other adapters does not appear in the catalog. The same applies
for Templates of Rack Servers that contain adapters other than these.

Also, if FEX N2K-C2232PP-10GE is selected, UCSC-PCIE-C10T-02 and UCSC-MLOM-C10T-02
does not appear in the catalog as these adapters cannot be connected to this FEX. Templates of Rack
Servers containing these adapters disappears from the catalog.

Procedure

In the Navigation pane, click the Emulator Settings menu tab.
Click Rack Integration

Select On or Off from the Direct Connect Rack drop-down menu.
Click Submit.

What to Do Next

Restart the VM and reset the database, as described in Persisting Settings During a Cisco UCS Platform
Emulator Restart, on page 22.

Modifying the Cisco UCS Platform Emulator Startup
Configuration Source

A

This setting determines which hardware inventory configuration is loaded into Cisco UCS Platform Emulator
when it restarts. By default, the current hardware inventory configured in Cisco UCS Platform Emulator is
loaded.

For example, you can use this setting to ensure that multiple Cisco UCS Platform Emulator VMs have the
same hardware inventory configuration. You can maintain the hardware inventory in a one Cisco UCS Platform
Emulator and configure the other Cisco UCS Platform Emulator VMs to use that hardware inventory.

Note

Changes to this setting do not take effect until you restart Cisco UCS Platform Emulator and reset the
database. If you restart or reboot Cisco UCS Platform Emulator, the Cisco UCS Manager database will
only be reset if the persistent setting is configured to reset the database. You can configure the persistent
setting in the Cisco UCS Platform Emulator VM Console (See Modifying System Settings Using VM
Console, on page 17) or using the Cisco UCS Platform Emulator GUI (Emulator Settings > Database
Persistence > Preserve or Reset).

Before You Begin

If you plan to load the hardware inventory configuration from another Cisco UCS Platform Emulator, you
must save that hardware inventory to ensure that it is available as a file.
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Step 1
Step 2
Step 3
Step 4

Step 5

Step 6

If you plan to load the hardware inventory configuration from a web server, you must export the hardware
inventory from an existing Cisco UCS Platform Emulator and store it on the web server.

Make sure that the Cisco UCS Platform Emulator cluster state setting is the same as the source cluster setting.

Procedure

In the Navigation pane, click the Emulator Settings menu tab.

Click Startup Config URL.

To use the local hardware inventory configuration, click the Use Local Startup Inventory radio button.
To load the startup configuration from another Cisco UCS Platform Emulator, do the following:

a) Click the Load From Another UCSPE radio button.
b) Complete the following fields:

Name Description

Host field The management IP address of the Cisco UCS Platform Emulator
from which you want to load the startup configuration.

Port field Port 80, the web server port used by Cisco UCS Platform Emulator.

File field The name of the saved hardware inventory configuration file in the

other Cisco UCS Platform Emulator that you want to load into this
Cisco UCS Platform Emulator on start up.

To load the startup inventory from a web server, do the following:

a) Click the Load From External URL radio button.

b) In the External URL field, enter the URL for the hardware inventory configuration file.
The URL should use a format such as http://IP Address/File Name. For example,
http://209.165.202.129/ucspe _hardware sample.xml

Click Submit.

What to Do Next

Restart the VM and reset the database, as described in Persisting Settings During a Cisco UCS Platform
Emulator Restart, on page 22.

Modifying the Fabric Interconnect Emulation Settings

This setting determines which fabric interconnect is used by Cisco UCS Platform Emulator and the number
of IOM links between the chassis and fabric interconnects.
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A

Dynamically Inducing and Clearing Faults .

Note

Step 1
Step 2
Step 3
Step 4

Step 5

If you restart or reboot using the VM console, the Cisco UCS Manager database will only be reset if the
persistent setting is configured to reset the database. You can configure the persistent setting in the Cisco
UCS Platform Emulator VM Console (See Modifying System Settings Using VM Console, on page 17)
or using the Cisco UCS Platform Emulator GUI (Emulator Settings > Database Persistence > Preserve
or Reset).

Procedure

In the Navigation pane, click the Emulator Settings menu tab.
Click Fabric Interconnect.
From the drop-down list, choose the number of IOM links between the chassis and fabric interconnects.

From the Fabric Interconnect drop-down list, choose which fabric interconnect you want to use in Cisco
UCS Platform Emulator.

Click Submit.

What to Do Next

Restart the VM and reset the database, as described in Persisting Settings During a Cisco UCS Platform
Emulator Restart, on page 22.

Dynamically Inducing and Clearing Faults

You can induce and clear faults using the Command Line Interface (CLI) and observe the fault behavior in
the GUL

Procedure
Command or Action Purpose
Step 1 <<cat <test.xmI> | POST http://<Ape Induces or clears faults by reading values
IP:8081>/nuova from the XML file.
Step 2 inChassisldChassis number Enters the chassis ID.
Step 3 inServerldServer number Enters the server ID.
Step 4 inSensorNameSensor name Enters the sensor ID.
Step 5 inFaultLevel Fault level Enters the fault level.
Step 6 inOperation / | 0 * 1 - Deletes a fault
* 0 - Adds a fault
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The following example shows how to dynamically induce and clear faults:

<methodVessel>

<inStimuli>

<apeSetApeSensorReading
inChassisId="1"
inServerId="5"
inSensorName="0"
inFaultLevel="6"
inOperation="1"

>

</apeSetApeSensorReading>
</inStimuli>
</methodvVessel>

Server Specific Sensor Listing for Blade and Rack Mounted

Servers

Table 9: Sensor List for Blade Servers

Blade Server

Sensor

B200M4

« P3V_BAT -0
«PI2 V-10

« TEMP_SENS_FRONT - 86
« TEMP_SENS_REAR - 87
«P1_TEMP_SENS - 88

« P2 TEMP_SENS - 89

« POWER_USAGE - 50

B200M3

« P3V_BAT SCALED --0
«PI2 V-8

« TEMP_SENS_FRONT - 76
« TEMP_SENS_REAR - 77
«P1_TEMP_SENS - 78

« P2 TEMP_SENS - 79

« POWER_USAGE - 40
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Blade Server

Sensor

B200M1
B200M2

« P3V_BAT SCALED - 0

« FM_TEMP_SENS IO - 47

« FM_TEMP_SENS REAR - 48
«P1_TEMP_SENS - 50

P2 TEMP_SENS - 49

B440M1
B440M2

« P3V_BAT SCALED -- 0
«P12 V-40

« TEMP_SENS_FRONT - 102
« TEMP_SENS_REAR_L - 103
« TEMP_SENS_REAR R - 104
«P1_TEMP_SENS - 107

P2 TEMP_SENS - 108
«P3_TEMP_SENS - 109

P4 TEMP_SENS - 110

« POWER_USAGE - 216

B250M1
B250M2

« P3V_BAT SCALED -- 0
« TEMP_SENS_FRONT - 81
« TEMP_SENS REAR - 82
«P1_TEMP_SENS - 83

- P2_ TEMP_SENS - 84

« POWER_USAGE - 197

B230M1
B230M2

« P3V_BAT SCALED -- 0
«P1_TEMP_SENS - 97
« P2 TEMP_SENS - 98

Cisco UCS Platform Emulator User Guide, Release 2.2(5aPE1) -



Configuring Cisco UCS Platform Emulator
. Server Specific Sensor Listing for Blade and Rack Mounted Servers

Blade Server Sensor

B420M3
« P3V_BAT SCALED -- 0

*PI2 V-8

« TEMP_SENS_FRONT - 114
« TEMP_SENS_REAR - 115
«P1_TEMP_SENS - 116

« P2 TEMP_SENS - 117

«P3_ TEMP SENS - 118

« P4 TEMP_SENS - 119

« POWER_USAGE - 224

B420M4
«PI2 V- 14

« TEMP_SENS_FRONT - 111
« TEMP_SENS_REAR - 112
«P1_TEMP_SENS - 113

P2 TEMP_SENS - 114

«P3_ TEMP SENS - 115

P4 TEMP SENS- 116

« POWER_USAGE - 46

B22M3
* P3V_BAT SCALED -- 0

«P12 V-8

« TEMP_SENS_FRONT - 57
« TEMP_SENS_REAR - 58
«P1_TEMP_SENS - 59

« P2 TEMP_SENS - 60

« POWER_USAGE - 113
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Table 10: Sensor List for Rack Mounted Servers

Server Specific Sensor Listing for Blade and Rack Mounted Servers

Rack Mounted Server Sensor
C220 M4

«P1_TEMP_SENS - 142

« P2 TEMP_SENS - 143
C240 M4

«P1_TEMP_SENS - 161

« P2 TEMP_SENS - 162
C22M3

« P3V_BAT SCALED -- 119
C24M3

«P1_TEMP_SENS - 46

« P2 TEMP_SENS - 47
C250M1

*« P3V_BAT SCALED --0
C250M2

« TEMP_SENS FRONT - 93

« TEMP_SENS REAR - 9%4

*PI_TEMP_SENS - 95

« P2 TEMP_SENS - 96
C260M2

« P3V_BAT SCALED -- 16

« TEMP_SENS FRONT - 78

« TEMP_SENS REAR 1-79

« TEMP_SENS REAR 2 - 80

«P1_TEMP_SENS - 81

« P2 TEMP_SENS - 82
C210M1

« P3V_BAT SCALED -- 0
C210M2

«P1_TEMP_SENS - 50

« P2 TEMP_SENS - 49

220M

C220M3 «P1_TEMP_SENS - 59

« P2 TEMP_SENS - 60
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Rack Mounted Server Sensor
C240M3 « P1_TEMP_SENS - 55
« P2 TEMP_SENS - 56
C460 M2 « P3V_BAT SCALED -- 0
«P1_TEMP_SENS-75
« P2 TEMP_SENS - 76
« P3_TEMP_SENS - 77
« P4 TEMP_SENS - 78
C420 M3

« P3V_BAT _SCALED -- 54

« TEMP_SENS_REAR 1 - 88
« TEMP_SENS_REAR 2 -89
«P1_TEMP_SENS - 94

« P2 TEMP_SENS - 95

« P3_TEMP_SENS - 96

« P4 TEMP_SENS - 97

Modifying Cisco UCS Configure IOM Links

You can configure the link between Fabric Interconnect and IOM for any chassis configured on the Control

Panel.

Procedure

Step1 In the Navigation pane, click Emulator Settings tab.
Step2 Click Configure IOM Links.
Step3 From the drop-down list of the chassis currently configured on the Control panel, select a chassis for which
you need to configure the IOM links.
Step4 From the mode of configuration drop-down list, choose Automatic or Custom.
Mode Description
Automatic Mode This mode lets the Platform Emulator to decide the

links between the IOM and Fabric Interconnect for
the selected chassis.
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Step 5

Modifying Cisco UCS Configure IOM Links .

Mode

Description

Custom Mode

This mode lets you enter the valid IOM and Fabric
Interconnect ports to configure the link between the
IOM and Fabric Interconnect for the selected chassis.

If you choose Automatic, the current connectivity information for the selected chassis is displayed to the
user. In HA mode, the connectivity of the two IOMs of the selected chassis is displayed.

If you choose Custom, editable text boxes containing the current connectivity information, depending on the
number of fixed links configured, are displayed.

Perform one of the following:

* If you choose Automatic, click submit to apply automatic link connectivity for the selected chassis.

All the ports are set to 0 and the Platform Emulator assigns link connectivity for the selected chassis

when UCSPE restarts.

* If you choose Custom, enter FI ports from 1 to maximum value as per the FI and IOM ports from 1 to
maximum value as per IOM in the text boxes. Click Submit after entering the ports.

Note  In Custom mode, the Fabric Interconnect and IOM ports entered by you are validated. If the
input entered conflicts with another configured link between a chassis and fabric interconnect,
the text box turns red color. Ensure that all the text boxes are green color after entering the
value. This ensures that all the entered ports are valid and the transaction is updated in the

database.

FI port and IOM port in each row connect to each other.

What to Do Next

Restart the Cisco UCS Platform Emulator and reset the database for the changes to take effect. If you restart
or reboot Cisco UCS Platform Emulator, the Cisco UCS Manager database only resets if the persistent setting
is configured to reset the database. You can only configure the persistent setting in the Cisco UCS Platform
Emulator GUI (Emulator Settings > Database Persistence > Preserve or Reset).
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CHAPTER

Configuring the Hardware Inventory

This chapter includes the following sections:

* Hardware Inventory, page 41

* Inventory Stash Area, page 42

e Chassis Area, page 43

» Viewing the Hardware Catalog, page 44

* Manually Configuring the Hardware Inventory, page 45

» Using Existing Hardware Inventory Configurations, page 52

Hardware Inventory

The inventory of supported hardware components is stored in the Hardware Catalog. This catalog is drawn

from the Capability Catalog that is included in Cisco UCS Platform Emulator. It contains the inventory of the
supported components that you can use to build a chassis in Cisco UCS Platform Emulator, including servers,
DIMMs, and adapters. If a component is not included in the Hardware Catalog, it is not supported by Cisco
UCS Platform Emulator.

The Hardware Catalog does not include fabric interconnects. You need to configure fabric interconnects and
the links between the chassis and the fabric interconnect in the emulator settings. For more information, see
Modifying the Fabric Interconnect Emulation Settings, on page 32.

Startup Hardware Inventory Icons

The following table contains the icons above the Stash and Chassis areas on the Startup Hardware Inventory

page.

Icon

Description

Description

Add New Chassis

Adds a chassis to the hardware inventory.
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this Hardware Setup

Icon Description Description
Load a Saved Loads a previously saved hardware inventory configuration. After
| Configuration you restart Cisco UCS Platform Emulator, this configuration
overwrites and replaces the current hardware inventory.
Import XML File Imports an XML file that contains hardware inventory configuration
data from a file on the local disk. After you restart Cisco UCS
Platform Emulator, this configuration overwrites and replaces the
current hardware inventory.
Import Equipment from | Imports the hardware inventory configuration from a live Cisco
| Live Cisco UCS UCS domain. After you restart Cisco UCS Platform Emulator, this
= configuration overwrites and replaces the current hardware
inventory.
Restart Emulator with | Restarts Cisco UCS Platform Emulator to enable the emulated Cisco

UCS Manager to discover the new hardware inventory configuration.

Save Configuration

Saves the current hardware inventory configuration. A file with this
name displays in the Load previously saved configuration list.

Export Configuration as
XML file

Exports the current hardware inventory configuration as an XML
file then opens a new browser tab and displays the contents of the
XML file.

Validate the present
Configuration

Validates the configuration.

Inventory Stash Area

The Stash area is a virtual lab desk where you can place a blade server after you remove it from, or before
you insert it into a chassis. You can change the components of a server in the Stash area, such as the DIMMs
or CPU, before you insert the server into a chassis. You can drag and drop servers into the Stash area from
the Chassis area (after ejection) or from the Hardware Catalog table below. If a server in the Stash area was
removed from a chassis, Cisco UCS Platform Emulator tracks the chassis and slot from which the server was
removed and reinserts it back into the same location when you drag and drop the server back into the Chassis

arca.
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Stash Area Icons .

You can drag and drop servers into the Stash area from the Chassis area or from the Hardware Catalog table
below. If a server in the Stash area was removed from a chassis, Cisco UCS Platform Emulator tracks the
chassis and slot from which the server was removed and reinserts it back into the same location when you
drag and drop the server back into the Chassis area.

Note

You can also drag and drop components or the servers directly on the chassis. However, be sure to populate
them accordingly. Incomplete configurations might result in failure.

Stash Area Icons

Icon Description

Collapses all elements of the Stash area.

Expands all elements of the Stash area.

Removes all servers and components from the Stash area.

Chassis Area

The Chassis area holds all of the chassis in Cisco UCS Platform Emulator. By default, the Chassis arca
includes one chassis. You can add more chassis at any time.

While you can modify servers in the Chassis area, we recommend that you drag the server from a chassis and
drop it in the Stash area and modify the server components there. When you drag the server back to the
Chassis area, Cisco UCS Platform Emulator returns it to the same chassis and slot from which it was removed.

Chassis Area Icons

Icon Description

Collapses all elements of the Chassis area.
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Icon Description

Expands all elements of the Chassis area.

Makes a duplicate of this chassis.

T
Disconnects the chassis from the fabric interconnect, but does not remove
Jﬂ it from the hardware inventory.

Removes the chassis from the hardware inventory.

Viewing the Hardware Catalog

Procedure

Step1 In the Navigation pane, click the Emulator Settings menu tab.
Step2 Click Hardware Catalog.

Step3 In the Work pane, click one or more of the following tabs to view the components supported in the current
release:

* Blades

« CPU

* DIMM

« HDD

* I/O Adapters
* Fans

* PSU

* Rack Servers

* Templates
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Manually Configuring the Hardware Inventory .

* Storage Controllers

Manually Configuring the Hardware Inventory

Adding a New Chassis

Step 1
Step 2
Step 3
Step 4
Step 5
Step 6

Procedure

In the Navigation pane, click the Emulator Settings menu tab.

Click Start-up Inventory.

On the Startup Hardware Inventory page, click the Add New Chassis icon on the top icon bar.
In the ID field, enter an unused number that you want to assign to the chassis.

In the Name field, enter a name for the chassis.

Click Add.
Cisco UCS Platform Emulator adds a Chassis area for the new chassis.

What to Do Next

Add components to the chassis.

Modifying Chassis Components

Step 1
Step 2
Step 3

Step 4
Step 5

Procedure

In the Navigation pane, click the Emulator Settings menu tab.
Click Start-up Inventory.

Click the row for the desired component, hold the mouse button down, and drag the component to the chassis
and drop it.

When prompted, enter the desired range for component slot(s) and press Enter.

Repeat Steps 3 and 4 until you add all the desired components.
Note  PSU and FANSs can only be added to a chassis. The input format should be
[a-b].

What to Do Next

Add servers to the chassis.
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Creating a New Blade Server

Step 1
Step 2
Step 3
Step 4

Step 5

Step 6

Step 7

We recommend that you create a new blade server in the Stash area. Blade servers that are moved from the
startup inventory table to the Stash area do not include any components, such as DIMMs, adapters, or fans.
You must add those components and build your blade server before you insert the blade server in a chassis.
After you have added all desired components to the blade server, you can drag it over to and drop it into a
chassis.

Procedure

In the Navigation pane, click the Emulator Settings menu tab.
Click Start-up Inventory.
On the Startup Hardware Inventory page, click the Blades tab.

Click in the row for the desired blade server and, holding the mouse button down, drag the blade server to the
Stash area and drop it into that area.

Add the components that you want to include in the blade server, as follows:

a) Click on the tab for the component you want to add to the blade server.

b) Click in the row for the desired configuration for the component and, holding the mouse button down,
drag the component to the Stash area and drop it on top of the blade server.

c¢) If prompted, enter the desired slot number for the component and press Enter.

d) Repeat Steps a through c until you have added all desired components to the blade server.

Add the blade server to a chassis:

a) Click on the blade server in the Stash area and, holding the mouse button down, drag the component to
the appropriate Chassis area and drop it into that area.

b) In the Enter Server Slot ficld, enter the number of the empty slot where you want to insert the blade
server and press Enter.
Dual-slot blade servers can only be added to odd numbered slots. If desired, click the Expand All icon in
the Chassis area to view which slots are occupied.

¢) Inthe Enter Server Slot field, enter the number of the empty slot where you want to insert the blade
server and press Enter.
Dual-slot blade servers can only be added to odd numbered slots. If desired, click the Expand All icon in
the Chassis area to view which slots are occupied.

Click the Validate icon in the Startup Hardware Inventory area to ensure that all necessary components for

a server are added. Missing components are displayed if the component is missing on the server.

Note  You can add the Cisco UCS Scalable M4 Blade Module in the scaled (4S) or non-scaled (2S) mode.
Once the blade is dropped on the chassis, you can choose to configure the blade in either the scaled
mode or the non-scaled mode. If you select the scaled mode, two blades are added and the user must
choose adjacent full-width slots as the local and peer slots. If you select the non-scaled mode, blades
are added in the pre-defined manner along with other components. When one of the servers in a
paired scaled setup is ejected, the pairing is lost.
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Creating a New Rack-Mount Server .

Creating a New Rack-Mount Server

)

We recommend you to create a new rack-mount server in the Stash area However, you can also drag-drop
the rack-server from the catalog to the Rack Server area. The UCS Platform Emulator supports only Cisco
Nexus 2232 Fabric Extender (FEX) for Rack connectivity.

Other components such as DIMMs, adapters, or fans are not included automatically. After you have added
all desired components to the rack-mount server in the Stash area, you can drag it and drop it into a Rack
Servers area. You can also configure the empty rack-mount server dropped directly on the Rack Servers
area, then add components. When you drop the first rack-mount server on the Stash area or Rack Servers
area, one or two FEXs are automatically added to the inventory depending on the Cluster state—If the cluster
state is HA: two FEXSs; if the cluster state is stand-alone: one FEX. When you drop a rack-mount server on
theRack Servers area, then connections between the rack-mount server and the FEX are applied on the
rack-mount server and its adapters by the backend of the Cisco UCS Platform Emulator GUI. Similarly, when
all FEX ports are occupied, then on the addition of a rack-mount server directly to the Rack Servers area,
or the addition of an adapter to a rack-mount server, or the shifting of a rack-mount server from the stash, will
cause connection overflows. This occurrence creates new FEXs for the future but the action will fail to
complete. If this situation occurs, you will need to perform the action again to make new connections by
default to these FEXs.

Note

Step 1
Step 2
Step 3
Step 4

Step 5

Step 6

You cannot individually select the Cisco Nexus 2232PP Fabric Extender. This is automatically added
when you create a rack-mount server.

Procedure

In the Navigation pane, click the Emulator Settings menu tab.

Click Start-up Inventory.

On the Startup Hardware Inventory page, click the Rack Servers tab.

Click in the row for the desired rack-mount server and, holding the mouse button down, drag the rack-mount
server to the Stash area and drop it into that area.

Add the components that you want to include in the rack-mount server, as follows:

a) Click on the tab for the component you want to add to the rack-mount server.

b) Click in the row for the desired configuration for the component and, holding the mouse button down,
drag the component to the Stash area and drop it on top of the rack-mount server.

¢) If prompted, enter the desired slot number for the component and press Enter.
d) Repeat Steps a through c until you have added all desired components to the rack-mount server.

Add the rack-mount server to a Rack Servers area:

a) Click on the rack-mount server in the Stash area and, holding the mouse button down, drag and drop the
component to the appropriate Rack Servers area.

b) Inthe Enter Server Slot field, enter the number of the empty slot where you want to insert the rack-mount
server and press Enter.
Dual-slot rack-mount servers can only be added to odd numbered slots. If desired, click the Expand All
icon in the Chassis area to view which slots are occupied.
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Modifying Server Components

A

We recommend that you eject the server that you wish to modify from the chassis into the Stash area, modify
the components as desired, then reinsert it into a chassis.

Note

Step 1
Step 2
Step 3

Step 4

Step 5

Adapters and storage controllers are inserted in the PCI slots of rack servers. So, when you drag and drop
the adapters or storage controllers on the rack server, ensure the PCI slot entered is available.

Procedure

In the Navigation pane, click the Emulator Settings menu tab.

Click Start-up Inventory.

Move the server you want to modify to the Stash area as follows:

a) In the appropriate Chassis area, click the + icon to expand the Servers.
b) Click the - icon next to the slot that holds the server you want to modify.

¢) Inthe Eject Server? field, click the green checkmark icon.
Cisco UCS Platform Emulator ejects the server from the chassis and moves it to the Stash area.

Add components to the server, as follows:

a) Click on the tab for the component you want to add to the server.

b) Click in the row for the desired configuration for the component and, holding the mouse button down,
drag the component to the Stash area and drop it on top of the server.

¢) If prompted, enter the desired slot number for the component and press Enter.
If the slot is occupied, Cisco UCS Platform Emulator replaces the existing component with the new one.

d) If prompted, enter the desired range for the component and press Enter.
If the slot is occupied, Cisco UCS Platform Emulator replaces the existing component with the new one.

Note  You can enter slot range only while adding DIMM, Disk, CPU, or PSU on rack servers and chassis
or while adding fans on chassis. The input for the range must be in the format [a-b]. It is not valid
for adapters.

e) Repeat Steps a through ¢ until you have modified all desired components in the server.

Reinsert the server into the chassis from which you ejected it, as follows:

a) In the Stash area, click on the + icon within the field for the server you want to reinsert.

b) Inthe Reinsert Server? field, click the green checkmark icon.
Cisco UCS Platform Emulator removes the server from the Stash area and reinserts the server into the
chassis and slot from which you ejected it.

Tip If you prefer, you can also drag the server from the Stash and drop it into another chassis with an
available slot.
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Duplicating a Chassis

Step 1
Step 2
Step 3

Step 4
Step 5
Step 6

Procedure

In the Navigation pane, click the Emulator Settings menu tab.
Click Start-up Inventory.

In the Chassis area for the chassis you want to duplicate, click the Duplicate this Chassis icon on the icon
bar.

In the ID field, enter an unused number that you want to assign to the chassis.

In the Name field, enter a name for the chassis.

Click Add.
Cisco UCS Platform Emulator adds a Chassis area with identical hardware components to the original chassis.

Disconnecting a Chassis from the Fabric Interconnect

A

This procedure does not remove the chassis from the hardware inventory. It is the equivalent of uncabling the
chassis from the fabric interconnects.

Note

Step 1
Step 2
Step 3

Step 4
Step 5

The chassis is not disconnected from the fabric interconnect until you restart the Cisco UCS Platform
Emulator application.

Procedure

In the Navigation pane, click the Emulator Settings menu tab.
Click Start-up Inventory.

In the Chassis area for the chassis you want to connect, click the Disconnect this Chassis from Switch icon
on the icon bar.

In the Disconnect this Chassis from Fabric Interconnect field, click the green checkmark icon to confirm.

Click the Restart the Emulator with this Hardware Setup icon on the icon bar to restart the Cisco UCS
Platform Emulator application and have this change take effect.

Connecting a Chassis to the Fabric Interconnect

This procedure is the equivalent of cabling the chassis to the fabric interconnects.
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A

Configuring the Hardware Inventory |

Note

Step 1
Step 2
Step 3

Step 4
Step 5

The chassis is not connected to the fabric interconnect until you restart the Cisco UCS Platform Emulator
application.

Procedure

In the Navigation pane, click the Emulator Settings menu tab.
Click Start-up Inventory.

In the Chassis area for the chassis you want to connect, click the Connect this Chassis to Fabric Interconnect
icon on the icon bar.

In the Connect this Chassis to Fabric Interconnect field, click the green checkmark icon to confirm.

Click the Restart the Emulator with this Hardware Setup icon on the icon bar to restart the Cisco UCS
Platform Emulator application and have this change take effect.

Removing a Chassis from the Hardware Inventory

)

With this procedure, Cisco UCS Platform Emulator removes the chassis and all servers in the chassis from
the hardware inventory.

Note

Step 1
Step 2
Step 3
Step 4
Step 5

The chassis and its servers are not removed from the hardware inventory until you restart the Cisco UCS
Platform Emulator application.

Procedure

In the Navigation pane, click the Emulator Settings menu tab.

Click Start-up Inventory.

In the Chassis area for the chassis you want to remove, click the Remove this Chassis icon on the icon bar.
In the Remove this Chassis ficld, click the green checkmark icon to confirm.

Click the Restart the Emulator with this Hardware Setup icon on the icon bar to restart the Cisco UCS
Platform Emulator application and have this change take effect.
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Emptying the Stash Area .

Emptying the Stash Area

Step 1
Step 2
Step 3
Step 4

Procedure

In the Navigation pane, click the Emulator Settings menu tab.
Click Start-up Inventory.
In the Stash area, click the Empty Stash icon on the icon bar.

In the Empty Stash? field, click the green icon to confirm that you want to empty the stash.
Cisco UCS Platform Emulator removes all servers and other components from the Stash area.

Configuring Hardware Inventory using SmartPlay and Templates

Configuring Hardware Inventory using SmartPlay Bundles

Step 1
Step 2
Step 3
Step 4
Step 5

Procedure

In the Navigation pane, click the Emulator Settings menu tab.

Click Start-up Inventory.

On the Startup Hardware Inventory page, click the SmartPlay Bundles icon on the top icon bar.
Select the desired SmartPlay Bundle from the drop-down list that you want to assign to the chassis.

Click Submit.
Cisco UCS Platform Emulator replaces the existing configuration with the SmartPlay Bundle configuration
including Fabric Interconnect.

Configuring Hardware Inventory using Templates

Step 1
Step 2
Step 3
Step 4

Procedure

In the Navigation pane, click the Emulator Settings menu tab.

Click Start-up Inventory.

On the Startup Hardware Inventory page, click the Templates tab in the Work pane.

From the list of templates, drag and drop the desired template on either the Chassis or Rack servers area.

* To configure hardware inventory for blade components, you must drag and drop the template in the
Chassis area.
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. Using Existing Hardware Inventory Configurations

Step 5

A

Note An error is shown if no slots are available on the
chassis.

* To configure hardware inventory for rack components, you must drag and drop the template in the Rack
servers area.

Click Submit.
Cisco UCS Platform Emulator replaces the existing configuration with the template configuration.

Note

A

If FEX N2K-C2232TM-E-10GE is configured on the Rack Integration tab, the rack server templates
containing the adapters other than the VIC 1225T or VIC 1227T disappears.

Note

If FEX N2K-C2232PP-10GE is configured on the Rack Integration tab, the rack server templates
containing the VIC 1225T or VIC 1227T disappears.

Using Existing Hardware Inventory Configurations

Importing a Hardware Inventory Configuration File

You can import a hardware configuration file that you exported from one Cisco UCS Platform Emulator into
another Cisco UCS Platform Emulator. You cannot import a backup file from a Cisco UCS domain. If you
want to import the configuration from a Cisco UCS domain, see Importing the Equipment from a Cisco UCS
Domain, on page 53.

Before You Begin

Changes to this setting do not take effect until you restart Cisco UCS Platform Emulator and reset the database.
If you restart or reboot Cisco UCS Platform Emulator, the Cisco UCS Manager database will only be reset if
the persistent setting is configured to reset the database. You can only configure the persistent setting in the
Cisco UCS Platform Emulator GUI (Emulator Settings > Database Persistence > Preserve or Reset).

Importing hardware inventory configuration from an XML file does not import the topology between
Fabric Interconnect and IOM. You can manually configure it using the Configure IOM Links.

Note

When a XML before 2.2(4bPE1) version is imported to the 2.2(4bPE1) setup, storage controllers might
not be added to the rack server if the storage controller slot is same as the adapter slot. If the adapter and
storage controller slots are same, insert the storage controller manually.
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Step 1
Step 2
Step 3
Step 4
Step 5
Step 6

Importing the Equipment from a Cisco UCS Domain .

In this release, after adding the multiple options for FEX, UCSPE imports the FEX with which the XML
dump is created.

Procedure

In the Navigation pane, click the Emulator Settings menu tab.

Click Start-up Inventory.

On the Startup Hardware Inventory page, click the Import XML File icon on the icon bar.
ClickBrowse and navigate to the file that you want to load into the Cisco UCS Platform Emulator.
Click Load File.

Restart the Cisco UCS Platform Emulator VM to overwrite and replace the existing hardware inventory
configuration with the new one, as follows:
a) On the Startup Hardware Inventory page, click the Restart Emulator with this Hardware Setup icon
on the icon bar.
b) Inthe Are you sure you want to reset UCSM Database and Restart UCS Emulator now? field, click
the Yes radio button.
¢) Click Reset UCSM Database and Restart UCS Emulator.
Note  The exported XML configuration now contains information about the fabric interconnect model,
number of IOM links, cluster configuration state and UCSM DB persistence status. When you import
this XML file, all these configurations are also imported along with the file.

Importing the Equipment from a Cisco UCS Domain

Before You Begin

Changes to this setting do not take effect until you restart Cisco UCS Platform Emulator and reset the database.
If you restart or reboot Cisco UCS Platform Emulator, the Cisco UCS Manager database will only be reset if
the persistent setting is configured to reset the database. You can only configure the persistent setting in the
Cisco UCS Platform Emulator GUI (Emulator Settings > Database Persistence > Preserve or Reset).

Note

Importing a configuration using HTTPS is now supported. If HTTPS is disabled on a Cisco UCS domain,
enable HTTPS redirection.

Importing from Live Cisco UCS domain does not import the topology between Fabric Interconnect and IOM.
You can manually configure it using the Configure IOM Links.
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. Loading a Saved Hardware Inventory Configuration

Step 1
Step 2
Step 3

Step 4

Step 5

Step 6
Step 7

Procedure

In the Navigation pane, click the Emulator Settings menu tab.
Click Start-up Inventory.

On the Startup Hardware Inventory page, click the Import Equipment from Live UCS icon on the icon
bar.

In the Cisco UCS Server field, enter the web link for the Cisco UCS Manager GUI of the Cisco UCS domain
from which you want to import the equipment.

The default web link is http: //UCSManager IP:port ,where UCSManager IP represents the IP
address assigned to Cisco UCS Manager. This IP address can be one of the following:

* Cluster configuration: UCSManager IP represents the virtual or cluster IP address assigned to
Cisco UCS Manager. Do not use the IP addresses assigned to the management port on the fabric
interconnects.

+ Standalone configuration: UCSManager IP represents the IP address for the management port on
the fabric interconnect

And where port represents the port used to access the Cisco UCS Manager GUI. By default, this port is 80
for HTTP access and 443 for HTTPS access.

Enter a valid user name and password for the Cisco UCS domain.
Any user with read-only or higher privileges can access the hardware inventory configuration.

Click Load.

Restart the Cisco UCS Platform Emulator VM to overwrite and replace the existing hardware inventory
configuration with the new one, as follows:

a) On the Startup Hardware Inventory page, click the Restart Emulator with this Hardware Setup icon
on the icon bar.

b) Inthe Are you sure you want to reset UCSM Database and Restart UCS Emulator now? field, click
the Yes radio button.

¢) Click Reset UCSM Database and Restart UCS Emulator.

Note  The exported XML configuration now contains information about the fabric interconnect model,

number of IOM links, cluster configuration state and UCSM DB persistence status. When you import
this XML file, all these configurations are also imported along with the file.

Loading a Saved Hardware Inventory Configuration

~

If you restart or reboot Cisco UCS Platform Emulator, the Cisco UCS Manager database will only be reset if
the persistent setting is configured to reset the database. You can only configure the persistent setting in the
Cisco UCS Platform Emulator GUI (Emulator Settings > Database Persistence > Preserve or Reset).

Note

Loading a saved configuration does not import the topology between Fabric Interconnect and IOM. You
can manually configure it using the Configure IOM Links.
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A

Saving the Current Hardware Inventory Configuration .

Note

Step 1
Step 2
Step 3

Step 4

Step 5

When a XML before 2.2(4bPE1) version is imported to the 2.2(4bPE1) setup, storage controllers might
not be added to the rack server if the storage controller slot is same as the adapter slot. If the adapter and
storage controller slots are same, insert the storage controller manually.

In this release, after adding multiple options for FEX, UCSPE imports the FEX with which the XML dump
is created.

Procedure

In the Navigation pane, click the Emulator Settings menu tab.
Click Start-up Inventory.

On the Startup Hardware Inventory page, click the Load a Saved Configuration icon on the icon bar.
Note  Only a user created configuration file is shown when you try to load a configuration
file.

In the menu below, click the link for the hardware inventory configuration you want to load into the Cisco
UCS Platform Emulator.

Restart the Cisco UCS Platform Emulator VM to overwrite and replace the existing hardware inventory

configuration with the new one, as follows:

a) On the Startup Hardware Inventory page, click the Restart Emulator with this Hardware Setup icon
on the icon bar.

b) Inthe Are you sure you want to reset UCSM Database and Restart UCS Emulator now? field, click
the Yes radio button.

¢) Click Reset UCSM Database and Restart UCS Emulator.

Note  The exported XML configuration now contains information about the fabric interconnect model,

number of IOM links, cluster configuration state and UCSM DB persistence status. When you import
this XML file, all these configurations are also imported along with the file.

Saving the Current Hardware Inventory Configuration

Step 1
Step 2
Step 3
Step 4

You can save the current hardware inventory configuration from the Startup Hardware Inventory page to
use in another Cisco UCS Platform Emulator VM or as a backup for the current VM. The configuration is
saved as an XML file.

Procedure

In the Navigation pane, click the Emulator Settings menu tab.
Click Start-up Inventory.
On the Startup Hardware Inventory page, click the Save Configuration icon on the icon bar.

In the File Name field, enter a name for the configuration file.
The file name must include only alphanumeric chars only, dashes (-) and underscores ( _ ). It cannot include
spaces.
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Step5 Click Save.
The configuration file is saved in Cisco UCS Platform Emulator and added to the saved configuration list.

Exporting the Hardware Inventory Configuration as an XML File

You can save the exported XML file with the hardware inventory configuration and then import it into another
Cisco UCS Platform Emulator or place it on a web server to use as a start up configuration.

Procedure

Step1 In the Navigation pane, click the Emulator Settings menu tab.
Step2 Click Start-up Inventory.

Step3 On the Startup Hardware Inventory page, click the Export Configuration as XML File icon on the icon
bar.
Cisco UCS Platform Emulator opens a new browser tab and displays the contents of the hardware inventory
configuration as an XML file.
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CHAPTER 7

Accessing Features in Cisco UCS Platform
Emulator

This chapter includes the following sections:

« Starting the Cisco UCS Manager GUI from the Cisco UCS Platform Emulator Control Panel, page 57
» Accessing Cisco DevNet, page 58

» Accessing goUCS, page 58

» Accessing Cisco UCS PowerTool, page 59

Starting the Cisco UCS Manager GUI from the Cisco UCS
Platform Emulator Control Panel

Step 1
Step 2
Step 3
Step 4

Step 5

You can use the Cisco UCS Manager GUI to configure and manage the hardware in your Cisco UCS Platform
Emulator environment.

For information about Cisco UCS Manager GUI commands, see the Cisco UCS Manager GUI Configuration
Guide. You can access this document through the Cisco UCS B-Series Servers Documentation Roadmap
available at the following URL: http://www.cisco.com/go/unifiedcomputing/b-series-doc .

Procedure

In the Navigation pane, click the UCS Manager menu tab.

Click UCS Manager Home.

In the Work pane, click Launch UCS Manager.

If a Security dialog box displays, do the following:

a) (Optional) Check the check box to accept all content from the IP address for Cisco UCS Platform Emulator.
b) Click Yes to accept the certificate and continue.

In the Login dialog box, do the following:

a) In the User Name field, enter config.
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b) In the Password field, enter config.
¢) Click Login.

Accessing Cisco DevNet

The Cisco DevNet provides information, documentation, and support resources for developers working with
Cisco UCS. You can also access information and documentation for the Cisco UCS Manager XML API from
the Cisco DevNet.

A

Note  Internet access is required in order to access the Cisco UCS Platform Emulator.

Procedure

Step1 In the Navigation pane, click the UCS Manager menu tab.
Step2 Click Cisco DevNet.

Accessing goUCS

Information About goUCS

goUCS is an application that allows you to view the communication between Cisco UCS Manager GUI and
Cisco UCS. This communication is through the Cisco UCS Manager XML API. goUCS parses the Cisco
UCS Manager GUI's log file and extracts the XML documents sent to Cisco UCS. goUCS also allows you to
substitute attribute values in captured XML documents in order to customize commands. goUCS can greatly
simplify UCS integration since programmers can mimick the Cisco UCS Manager GUI operations and
customize them if necessary.

goUCS enables you to automate any action that can be performed in the Cisco UCS Manager GUI, including:
* Query for data
* Modify existing objects in the Cisco UCS domain
» Complete complex tasks in a single transaction, such as the following:
» Create ten service profiles from a service profile template
° Associate each of those service profiles with a server

°Power on each of the servers
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Downloading goUCS
Y

Note  Cisco UCS Platform Emulator must have access to the internet to download goUCS.

Procedure

Step1 In the Navigation pane, click the UCS Manager menu tab.
Step2 Click GoUCS Tool Download.

Step3 In the Work pane, review the information and follow the instructions to download goUCS.

Accessing Cisco UCS PowerTool

Information about Cisco UCS PowerTool

Cisco UCS PowerTool is a Microsoft PowerShell command line toolkit and interface to Cisco UCS. You can
use Cisco UCS PowerTool to integrate, automate, and orchestrate all aspects of Cisco UCS management
within the data center, including network, storage and hypervisor management.

Cisco UCS includes over 1800 PowerShell command-lets (“cmdlets”) that enable you to integrate and automate
Cisco UCS with Microsoft products and many third party products.

Downloading Cisco UCS PowerTool

A

Note Cisco UCS Platform Emulator must have access to the internet to download Cisco UCS PowerTool.

Procedure

Step1 In the Navigation pane, click the UCS Manager menu tab.
Step2 Click GoUCS Tool Download.

Step3 In the Work pane, review the information and follow the instructions to download Cisco UCS PowerTool.
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CHAPTER

Using the Managed Object Browser

This chapter includes the following sections:

 Information About the Managed Object Browser, page 61
* Managed Object Browser Page, page 61
¢ Running a Query in the Managed Object Browser, page 63

Information About the Managed Object Browser

o

Tip

The Managed Object Browser, or Visore, that you can access through Cisco UCS Platform Emulator provides
you with a graphical view of the managed objects in the XML database. You can also use the Managed Object
Browser to find out what type of data Cisco UCS stores in the database for each type of managed object. In
addition, since the Managed Object Browser uses the Cisco UCS Manager XML API to query the runtime
managed objects and display the results, it also enables you to see the query that was used to obtain the
information from the database.

For example, you can use the Managed Object Browser to see which service profiles have been configured
and the XML query that was used to access that information in the database. You can also use it to view the
type of data stored in the database about servers, such as the number of cores, the type of adapter, or the
number of CPUs. You can then use that information when you design or debug a Cisco UCS domain.

You can also connect to and run queries with the Managed Object Browser on a running Cisco UCS
domain through the following URL: http://UCSManager IP:port number/visore.html.

Managed Object Browser Page

Filter Area

The filter form is case sensitive. This area supports all simple Cisco UCS Manager XML API operations.
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Name Description
Class or DN field Object class name or full distinguished name of a managed object.
Property field The property of the managed object on which you want to filter the

results. If you leave the Property field empty, the search returns all
instances of the specific class.

Op drop-down list

Operator for the values of the property on which you want to filter the
results. The following are valid operators are:

» ==—equal to

* !=—not equal to

» <—less than

* >—agreater than

* <—1less than or equal to

» 2—greater than or equal to
* between

+ wildcard

+ anybit

« allbits

Vall field

The first value for the property on which you want to filter.

Val2 field

The second value on which you want to filter.

Display XML of Last Query Link

The Display XML of last query link displays the full Cisco UCS Manager XML API translation of the most
recent query run in the Managed Object Browser.

Results Area

You can bookmark any query results page in your browser to view the results again because the query is

encoded in the URL.

Note

- Cisco UCS Platform Emulator User Guide, Release 2.2(5aPE1)

Many of the managed objects are only used internally and are not generally applicable to Cisco UCS

Manager program development.

Name

Description

Pink background

Separates individual managed object instances and displays the class
name of the object below it.
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Name Description

Blue or green background Indicates the property names of the managed object.

Yellow or beige background Indicates the value of a property name.

dn property Absolute address of each managed object in the object model.

dn link When clicked, displays all managed objects with that dn.

Class name link When clicked, displays all managed objects of that class.

Left arrow When clicked, takes you to the parent object of the managed object.
Right arrow When clicked, takes you to the child objects of the managed object.
Question mark Links you to the XML API documentation for the managed object.

Running a Query in the Managed Object Browser

Procedure

Step1 In the Navigation pane, click the UCS Manager menu tab.
Step2 Click Managed Object Browser.

Step3 In the Work pane, In the Class or DN field, type the class or DN of the managed object you want to query.
This is the only required field in a query. For information about the available classes or DNs, see the Cisco
UCS Manager XML API documentation.

Example:

If you want to search on all instances of the blade class in the object model, enter computeBlade in the Class
or DN field. However, if you want to limit the query to a specific server, such as blade server 1 in chassis 1,
enter sys/chassis-1/blade-1.

Step4 (Optional) If you want to filter the results of your query, complete the following fields:

Name Description

Property field Enter a property of the managed object on which you
want to filter the results of the search. For example,
if you are querying computeBlade, you could enter
association.
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Using the Managed Object Browser

Description

Op drop-down list

Choose the operator on which you want to filter the
values for the property. This can be:

==, I=,< >, £ 2 between, wildcard, anybit, allbits

o ==——¢qual to

* !=—not equal to

» <—]less than

» >—greater than

* <—1less than or equal to

» 2—greater than or equal to
* between

* wildcard

+ anybit

« allbits

Vall field

Enter an available value for the property entered in
the Property field. For example, if you are filtering
on the association property, you could enter
unassociated.

Val2 field

Enter an available second value for the property
entered in the Property field.

Step5 Click Run Query



CHAPTER

Accessing the Cisco UCS Manager XML API
Documentation

This chapter includes the following sections:

 Information About the Cisco UCS Manager XML API, page 65
 Information About the Cisco UCS Manager XML API Documentation, page 66
» Accessing the Cisco UCS Manager XML API Documentation, page 66

Saving the Cisco UCS Manager XML API Schema and Samples, page 67

Information About the Cisco UCS Manager XML API

The Cisco UCS Manager XML API is a programmatic interface to Cisco Unified Computing System (UCS).
The API accepts XML documents through HTTP or HTTPS. Developers can use any programming language
to generate XML documents that contain the API methods. Configuration and state information for Cisco
UCS is stored in a hierarchical tree structure known as the management information tree, which is completely
accessible through the XML API.

The Cisco UCS Manager XML API supports operations on a single object or an object hierarchy. An API
call can initiate changes to attributes of one or more objects such as chassis, blades, adapters, policies, and
other configurable components.

The API operates in forgiving mode. Missing attributes are replaced with applicable default values that are
maintained in the internal data management engine (DME). The DME ignores incorrect attributes. When
multiple managed objects (MOs) are being configured, the API operation stops if any of the MOs (a virtual
NIC, for example) cannot be configured. In that case, the management information tree is rolled back to the
prior state that preceded the API operation and an error is returned.

Updates to MOs and properties conform to the existing object model to ensure backward compatibility. If
existing properties are changed during a product upgrade, they are managed during the database load after
the upgrade. New properties are assigned default values.

Operation of the API is transactional and terminates on a single data model. Cisco UCS is responsible for all
endpoint communication, such as state updates. Users cannot communicate directly to endpoints, which
relieves developers from administering isolated, individual component configurations.

The API model includes the following programmatic entities:
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* Classes—Define the properties and states of objects in the management information tree.

* Methods—Actions that the API performs on one or more objects.

* Types—Object properties that map values to the object state (for example, equipmentPresence).
A typical request comes into the DME and is placed in the transactor queue in FIFO order. The transactor
gets the request from the queue, interprets the request, and performs an authorization check. After the request

is confirmed, the transactor updates the management information tree. This complete operation is done in a
single transaction.

Full event subscription is enabled. After subscribing, any event notification is sent along with its type of state
change.

Information About the Cisco UCS Manager XML API
Documentation

The Cisco UCS Manager XML API documentation that you can access through the Cisco UCS Platform
Emulator provides information about the Cisco UCS Manager information model

When you view the XML API documentation, the navigation frames on the left list the following information:
* Managed objects
» Methods
* Types
* Fault rules

* Finite State Machine (FSM) rules

For more information about the Cisco UCS Manager XML API, see the Cisco UCS Manager XML API
Programmer's Guide.

Accessing the Cisco UCS Manager XML APl Documentation

Procedure

Step1 In the Navigation pane, click the UCS Manager menu tab.

Step2 Click XML API Docs.
The XML API docs are displayed in the Work pane. The links provide navigation through the information
model.
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Saving the Cisco UCS Manager XML APl Schema and Samples

Cisco provides the Cisco UCS Manager XML API schema and samples for you use as a reference when
programming with the Cisco UCS Manager XML APIL.

Procedure

Step1 In the Navigation pane, click the UCS Manager menu tab.
Step2 Click API Schema & Samples.
Step3 Follow the prompts to save and extract the files to a location on your hard drive.
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